
Installation Guide
for the

Intel® Server Control
Order Number: 747116-011

This guide explains how to install and launch the Intel® Server Control (ISC) software. ISC is a
server management tool that provides real time monitoring and alerting for server hardware,
emergency remote management, and remote server setup. It is implemented using a client-server
architecture.
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Platform Compatibility

Feature availability can depend on which version of the Intel® Server Control (ISC) is running on
which platform. Specifically, compatibility is an issue when an ISC 3.1 console is managing a
network of systems that are running older versions of ISC. For feature availability, refer to the
Platform Compatibility Matrix beginning on page 23 near the end of this guide.

Download from Www.Somanuals.com. All Manuals Search And Download.



6 Installation Guide for the Intel Server Control

System Requirements

ISC contains two parts:

• ISC Console Software
• ISC Server Instrumentation Software

ISC Console Software allows interaction with the managed server. It can be installed on these
system configurations:

• Windows NT† 4.0 server or workstation, Enterprise Edition
• Windows† 98 Second Edition workstation
• Windows 2000 workstation

ISC Server Instrumentation Software, when installed, creates a managed server that can be
managed from the system running ISC Console Software. It can be installed on these systems:

• Windows NT 4.0 server
• Windows 2000 server
• NetWare† server
• UnixWare† server
• Linux† 6.2 server

Managed Server Requirements
ISC supports several Intel® motherboards. For a complete list of supported server motherboards
and qualified BIOS revision levels, see the files README.TXT and ERRATA.TXT. You can find
these file in the appropriate language directory of the Docs directory on the Software Kit CD. The
following requirements must be met for a managed server.

Windows 2000/NT Requirements
• Windows 2000 Advance Server, NT Server 4.0 (SP 6a), or Enterprise Edition
• 64 MB of RAM
• 60 MB of available disk space
• Windows NT SNMP or SNMP service installed (required only for connectivity to an SNMP

management console)

NetWare Requirements
• NetWare 4.2 SP8a or 5.1 SP1 symmetric multiprocessing (SMP)
• At least 95 MB of RAM
• At least 60 MB of available disk space
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Red Hat Linux Requirements

If you intend to manage a Linux file server, it must meet the following minimum requirements:

• Red Hat Linux 6.2 SBE 2 running in multiple-processor kernel
• 32 MB of RAM
• 60 MB of available disk space

SCO UnixWare Requirements

If you intend to manage a UnixWare file server, you must have an account with root privileges
available to you. The server must also meet the following minimum requirements:

• SCO UnixWare v7.1.1
• 32 MB of RAM
• 60 MB of available disk space

Additional Requirements for DMI-SNMP Translation

Simple Network Management Protocol (SNMP) support must be installed if you want to integrate
ISC with an SNMP-based management framework. For SNMP installation information, see your
Windows NT, NetWare, or UnixWare documentation.

On the managed server, you should consider the following issues when configuring SNMP:

• Community string names for SNMP Get and Set operations
• Community string names for sending traps
• The destination address for the management console receiving the traps

On the management console, you should consider the following issues when configuring SNMP:

• Compiling the MIBs into the SNMP management consoles
• Integration of ISC traps into SNMP management consoles

Console Requirements
Console System requirements may change when snapping into one of the supported management
applications. Please refer to their installation requirements for additional information.

ISC Console Software integrates into an Enterprise System Management Console or it can be
installed on a stand-alone console. The required Enterprise System Management Consoles are:

1. Intel® LANDesk® Server Management 6.xx
2. HP OpenView† Network Node Manager 6 for Windows NT
3. CA UnicenterTNG† 2.2 for Windows NT

A stand-alone console manages ISC-enabled servers without Enterprise System Management. It is
implemented as an ActiveX† control that runs within its own container or third party container
application (e.g., Microsoft Management Console, Internet Explorer† v5.0 or later, or Netscape
Navigator† v3.0 or later with ActiveX† snap-in). You can choose the stand-alone environment
during setup. If you do not choose the stand-alone environment and no management console is
present, the ISC software will not install.
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Windows 98 Second Edition
• Intel® Pentium® microprocessor or higher.
• At least 32 MB of RAM.
• At least 10 MB of available disk space.
• Microsoft Windows compatible modem must be used for if you connect to the server by

modem.

Windows 2000/NT
• Windows 2000/NT Server, or Workstation 4.0 (SP 6a), or Enterprise Edition.
• Intel Pentium microprocessor or higher.
• At least 64 MB of RAM.
• At least 10 MB of available disk space.
• For Windows NT, Remote Access Service must also be installed. If it is not installed the Direct

Platform Control (DPC) component will not install.
• Microsoft Windows compatible modem must be used for if you connect to the server by

modem.
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Service Partition and Population

The service partition is a special hard disk partition. It is established when initially setting up the
server system and contains utilities, diagnostics, and other software required for remote
management. The service partition is not marked as an active partition and the server will only
boot from it by a special request. It is not normally visible to the server user because it has a
special non-standard partition type that does not appear as an accessible file system to the end user
operating system. However, low level disk utilities can see the partition entry as an unknown type,
and recognize its space.

The utilities and diagnostics on the service partition can be run locally or remotely. In order to run
the utilities and diagnostics the server must boot from the service partition. Remote execution is
available from the Direct Platform Control (DPC) Console Manager and System Setup Utility
(SSU) Client.

Service Partition Installation
It is recommended that you install the service partition:

• On a clean formatted hard drive with no partitions defined.
• Before installing any operating system.

It can also be installed on a hard drive that contains partitions, providing there is unpartitioned
space and one free entry in the partition table. However, these are not recommended because some
operating systems may no longer boot if partitions are added or removed after that OS has been
installed.

Requirements
• The SP can be on any of the first 8 BIOS-supported physical hard drives.
• SP hard drives must support BIOS INT13.
• Current ECO BIOS must be installed.
• Remove old service parititions and create service partition with current Software Kit CD.
• At least 50 MB of unused (not partitioned) hard drive space. On large hard drives this unused

space must be within the first 8 GB.
• A service partition does not already exist on the hard drive.

✏     NOTE
There are commercial utilities that can resize existing partitions to free space
if more is needed. Alternately, you can add a low capacity hard drive for the
service partition.
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Installation

This procedure is for installing the SP on a clean formatted hard drive only.

CAUTION
To prevent data loss, do not attempt to run the installation utility from any
device other than the Software Kit CD.

1. Backup all data on all hard drive.
2. Disable all system features that prevent writing to the hard drive boot sector.
3. Insert the Software Kit CD into the CD-ROM reader.
4. Restart the server.
5. When the “F2 to enter setup” message appears, quickly press F2 to enter Setup.
6. In Setup, use the arrow keys to select the Boot menu.
7. Use the arrow keys to select Boot Device Priority then press Enter.
8. Select ATAPI CDROM and use the + key to move the selection to the top of the list.
9. Press F10.
10. Select Yes to confirm saving of the current settings and press Enter. The server restarts and

boots from the Software Kit CD.
11. When the Server Board CD-ROM menu appears, use the arrow keys to select the Utilities menu

and press Enter.
12. Select Run Service Partition Administrator and press Enter.
13. Choose item 3 - Create service partition (first time).
14. Follow the instructions on your screen to select the hard drive for service partition installation.
15. The utility creates the service partition and informs you that it will reboot the server when you

press any key.
16. The server reboots from the Software Kit CD.
17. When the Server Board CD-ROM menu appears, use the arrow keys to select the Utilities menu

and press Enter.
18. Select Run Service Partition Administrator and press Enter.
19. Choose item 4 - Format service partition and install software.
20. Follow the instructions on the screen to format the service partition and install the partition

software.
21. Quit the Server Board CD-ROM menu.
22. Remove the Software Kit CD from the CD-ROM reader.
23. You can now install the user operating system.
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Boot the Server from the Service Partition
Boot the server from the service partition when you want to run the utilities and diagnostics found
on the service partition. You can reboot a server:

• Locally
• Remotely
• Using the DPC console manager
• Using the Client SSU

Locally Booting the Server from the Service Partition Boot
1. Restart the server.
2. When the “F2 to enter setup” message appears, quickly press F2 to enter Setup.
3. In setup, use the arrow keys to select the Server menu.
4. Select Service Boot and press Enter.
5. Choose Enabled and press Enter. The Service Boot option resets to Disabled after the next

system boot.
6. Press F10.
7. Select Yes to confirm saving of the current settings and press Enter. The server restarts and

boot from the service partition.

Remotely Booting the Server from the Service Partition Boot

You can remotely boot the server from the service partition using the DPC Console Manager or the
SSU Client.

Configuring EMP and Console Redirection Settings

To take advantage of DPC and CSSU features, the Emergency Management Port (EMP) and
console redirection settings must be configured using the server System Setup Utility (SSU).

1. Insert the Software Kit CD into the CD-ROM reader.
2. Restart the server.
3. When the “F2 to enter setup” message appears, quickly press F2.
4. In Setup, use the arrow keys to select the Boot menu.
5. Use the arrow keys to select Boot Device Priority then press Enter.
6. Select ATAPI CDROM and use the + key to move the selection to the top of the list.
7. Press F10.
8. Select Yes to confirm saving of the current settings and press Enter. The server restarts and

boots from the Software Kit CD.
9. When the Server Board CD-ROM menu appears, use the arrow keys to select the Utilities menu

and press Enter.
10. Select “Run System Utility” under the “Utilities” menu. You will see SSU executables

installed the first time and then the Server SSU launches.
11. In the Available Tasks list select Platform Event Manager and click OK.
12. Click the Configure EMP button.
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13. Enter the following in the Emergency Management Port (EMP) dialog box:

Option Entry

Enter New Password: Enter the EMP password, up to 16 characters.

Verify New Password: Re-enter the EMP password.

ESC Sequence: +++ (default)

Hangup String: ATH (default)

Modem Init String: ATE1Q0V1X4&D0S0=0 (default). May require change based on the installed
modem requirements.

System Phone Number: The phone number to access the EMP port connect to port COM2.

Access Mode: Always Active. [default is Preboot]

Restricted Mode: Disable. [default is Enable]

Connection Mode: Modem Connect(default) for modem connections to COM2. Serial Connect
for direct serial connections to COM2.

14. Click Save, then Close.
15. Exit from the Server SSU.
16. Quit the Server Board CD-ROM menu.
17. Remove the Software Kit CD from the CD-ROM reader.
18. Reboot server and select F2 to re-enter BIOS setup.
19. Select Server.
20. Toggle “LAN Redirection” to enable.
21. Press “ESC” and save changes before rebooting.

Configuring the Server for LAN Access

To take advantage of LAN access and BMC LAN-Alerts features, server settings must be
configured using the server System Setup Utility (SSU). After the settings are initialized they can
be changed using the Client System Setup Utility (CSSU).

If you are going to define a SNMP community, be sure to do it before installing ISC.

1. Insert the Software Kit CD into the CD-ROM reader.
2. Restart the server.
3. When the “F2 to enter setup” message appears, quickly press F2.
4. In Setup, use the arrow keys to select the Boot menu.
5. Use the arrow keys to select Boot Device Priority then press Enter.
6. Select ATAPI CDROM and use the + key to move the selection to the top of the list.
7. Press F10.
8. Select Yes to confirm saving of the current settings and press Enter. The server restarts and

boots from the Software Kit CD.
9. When the Server Board CD-ROM menu appears, use the arrow keys to select the Utilities menu

and press Enter.
10. Select “Run System Utility” under the “Utilities” menu. You will see SSU executables

installed the first time and then the Server SSU launches.
11. In the Available Tasks list select Platform Event Manager and click OK.
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12. Click the Configure LAN button.
13. Enter the following on the BMC LAN Configuration (LAN) dialog box:

Option Entry

Enable LAN Alerts: Click to enable BMC LAN-alerts.

Enter New Password: Enter the BMC LAN Configuration password, up to 16 characters. Default is
NULL. This will be used for all LAN connections in CSSU, DPC, PIC, and
BMC LAN-alerts.

Verify New Password: Re-enter the BMC LAN Configuration password.

LAN Access Mode: Full Access, which allows DPC and CSSU access via LAN. By default, LAN
access inside is disabled.

SNMP Community String: Public (default) unless there is predefined SNMP host to receive SNMP traps
from BMC LAN-Alerts. Must be from 5 to 16 characters.

IP Configuration: Static (default) unless you are using DHCP for IP hosting, then select DHCP.

Host IP Address: Enter the IP address of the server if you are not using DHCP.

Gateway IP Address: Enter the IP address of the router if you are not using DHCP.

Subnet Mask: Enter the subnet mask of the hosts on the subnet if you are not using DHCP.

Alert IP Address: Enter the IP address of the server to receive SNMP traps for the community
defined with the SNMP Community String. Enter 0.0.0.0 (default) if a
community is not defined.

14. Click Save, then Close.
15. Exit from the Server SSU.
16. Quit the Server Board CD-ROM menu.

Using the DPC Console Manager
1. Connect to the appropriate server.
2. Select Reboot Service Partition from the Action menu.

Using the Client SSU
1. Select (Re)Connect from the Server menu.
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Installing ISC

Managed Server Preparation
ISC uses the event-logging feature of the BIOS for system management status and information. To
enable this feature for each server to be managed with ISC, you must boot the server(s) using the
System Configuration Utility (SCU) or System Setup Utility (SSU) and set the appropriate options
under System Management Options.

✏     NOTE
It is possible to configure temperature and voltage thresholds on the server
system using the SCU or SSU. However, the thresholds set with the SCU or
SSU are in effect only for a short time during the system boot process. PIC
overwrites these thresholds when the OS loads. It is recommended that all
threshold changes be made using Platform Instrumentation Control (PIC).

Compatibility and Upgrade Issues
The following paragraphs describe compatibility and upgrade issues for:

• LSC and LDSM
• NetWare
• Windows NT
• Windows 98 Second Edition
• UnixWare
• Red Hat Linux
• Windows 2000

LSC and LDSM

If you have earlier versions of LSC or LDSM on your network, be aware of the following:

• Versions of LSC integrated with LDSM (e.g., LDSM with LSC55) are not supported
under ISC.

• The ISC-managed server installation will not upgrade the DMI service provider or any DMI
database that is already installed on the managed server. However, if a service provider is not
found, ISC installs a DMI 2.0 service provider.

• The ISC server installation process installs the remote procedure call (RPC) transports (DCE
and ONC) if they are not available on the managed server.

• ISC ships with the DMI 2.0s Service Provider for Windows NT. The 2.0s version is an
extension of the Service Provider that supports security. ISC does not use those features, but
they are available under Windows NT for possible use by other DMI 2.0s-compliant software.
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NetWare

For installation on systems using NetWare, be aware of the following:

• Connect as a user with supervisor rights when installing ISC to a NetWare server.
• All NetWare servers require two manual reboots following the ISC installation.
• The TiRPC runtime library for ONC RPC or a substitute file set for NetWare5x must be

running.

Windows NT

For installation on systems using Windows NT, be aware of the following:

• Connect as a user with supervisor rights when installing ISC to a Windows NT server.
• The ISC installation program automatically reboots both remote and local servers as necessary.
• Remote Access Service (RAS) must be previously be installed on the console for if

connectivity will use a modem.

Windows 98 Second Edition

For installation on systems using Windows 98 Second Edition, be aware of the following:

• A manual reboot is required following the ISC installation.
• Remote Registry must be previously installed on the console.

UnixWare

For installation on systems using UnixWare, be aware of the following:

• Connect as root user when installing ISC to a UnixWare server.
• A plain text password must be enabled in the registry. If the password is not enabled, an extra

reboot following ISC installation will be required on each UnixWare server.
• Vision FS must be installed, configured, and running.
• Mcopy must be installed on each ISC managed UnixWare server. Please refer to the man page

for doscp for download and install instruction for mcopy. Mcopy can also be installed by
installing the mtools package from Skunkware 7 CD-ROM.

• A manual reboot is required for each server following the ISC installation.
• The server automatically reboots following ISC installation.

By default, SCO UnixWare v7.1.1 systems have DMI access set to read-only. This setting prevents
ISC from changing sensor thresholds, enabling the watchdog timer, and executing other functions.
To allow ISC to operate correctly, DMI access write permission must be enabled. Do the following
to enable DMI access to write:

1. Log in as 'root'.
2. Stop the DMI Service Provider (dmi stop).
3. Open the file /etc/rc2.d/S89dmi for editing.
4. Change the line $DMI_PATH $@ to $DMI_PATH $@ -w.
5. Save the file and restart the DMI Service Provider (dmi start).

This change is valid for all future sessions.
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Red Hat Linux

For installation on systems using Red Hat Linux, be aware of the following:

• Remote ISC installation is not available.
• Additional steps are required to configure the Linux DMI service provider.
• Additional steps are required to configure the SNMP-DMI mapper.

Windows 2000

When upgrading to ISC 3.1, the previously installed service partition must be removed and
recreated using utilities supplied with ISC 3.1. The system BIOS must also be upgraded.

LSC, LDSM, Windows, NetWare, and UnixWare
Installation

The ISC package contains both the console and instrumentation software. To install, launch
ISCSetup.exe if it is downloaded from the web or Launch Binaries\Setup.exe if it is from a
CD-ROM. Remote installation for server instrumentation software is supported for
Windows 2000/NT or Novell server. The console software installation can only be installed
locally. Select all the server(s) to be installed and follow the instruction on the screen to continue.
After the installation is completed, reboot the server to complete the installation:

• Each Windows 2000/NT server automatically reboots.
• Each NetWare, UnixWare, or Linux server requires manual reboot.

1. Login with system administrator access.
2. Verify the HP OpenView is not running.
3. Do steps 4 and 5 then skip step 6 if you are installing from the Software Kit CD. Skip to step 6

if you are installing from a download from the web.
4. At the console, insert the Software Kit CD into the CD ROM reader.
5. Run the program x:\binaries\setup.exe, where x in the drive letter of your CD ROM reader.
6. Run the program ISCsetup.exe from the ISC download directory.
7. Note this installation may require multiple server reboots.

When installation is complete, view the file logfile in the install directory of each server and
console to verify that ISC installed correctly.

Red Hat Linux Installation
There are three steps to the Red Hat Linux installation process:

• Installing Linux DMI server provider
• Installing ISC
• Configuring the SNMP_DMI mapper

Download from Www.Somanuals.com. All Manuals Search And Download.



Installation Guide for the Intel Server Control 17

Installing Linux DMI Service Provider
1. Insert the Software Kit CD into the Linux server CD ROM reader.
2. Mount the CD using either of the following methods:

• Enter the mount command as follows:
mount /mnt/cdrom

• Use the Disk Management utility. To invoke this utility click the Start button, select
System, and then select the Disk Management menu option.

3. Uninstall ucd-snmp if it has been installed previously with rpm –e.

✏     NOTE
If you uninstall ucd-snmp, you must also remove all related snmp and
DMI packages. When you remove these packages, remove them in an
order that eliminates dependency error messages. For example, if a
dependency error message appears, remove the package mentioned in
the error message. Continue removing the dependent packages in this
manner until the error messages stop.

4. Install the DMI service provider package located in the \Software\Linux\dmisnmp directory on
the Software Kit CD by using the rpm command. For example, the following command installs
a version of the DMI service provider package:

rpm –i dmisp-1.0-6.i386.rpm

5. Locate and install the ucd-snmp RPM, ucd-snmp-utils RPM, and dmi2snmp RPM packages.
These packages are also located in the \Software\Linux\dmisnmp directory on the Software Kit
CD. Use the rpm command to install each package. For example, the following three
commands install versions of these three packages:

rpm –i ucd-snmp-4.1.1-15smux.i386.rpm

rpm –i ucd-snmp-utils-4.1.1-15smux.i386.rpm

rpm –i dmi2snmp-1.0-15.i386.rpm

6. Reboot the Linux server after you have installed all the packages.

Installing ISC Server Instrumentation
1. Insert the Software Kit CD into the Linux server CD ROM reader.
2. Mount the CD using either of the following methods:

• Enter the mount command as follows:
mount /mnt/cdrom

• Use the Disk Management utility. To invoke this utility click the Start button, select
System, and then select the Disk Management menu option.

3. List the contents of the Software Kit CD and make sure the ISC install packages and scripts are
on the CD. You can locate these packages in the /Software/Linux directory. Use the following
commands to move to that directory and list the files:

cd /mnt/cdrom/Software/Linux
ls
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You should see file names similar to the following:

ipmidrvr-2.2.14.6.1.1smp-1.i386.rpm
ipmidrvr-2.2.16.22smp-1.i386.rpm
isc-3.1-1.i386.rpm
installme

4. Run the ISC install script from the directory you listed in the previous step by entering the
following command at the command-line prompt:

./installme

5. Follow the instructions on your screen. The script prompts you to read and accept a license
agreement. Next, the ISC install program determines the version of the Red Hat Linux kernel
running on your server and installs the right version of the IPMI driver on your server. The
script then proceeds to install the ISC package (e.g. isc-3.1-1.i386.rpm) on your server. In case
the installation of the driver fails, the script displays appropriate error messages and then
terminates without installing the ISC package.

6. Reboot the Linux server when the command completes.

Configuring the SNMP–DMI Mapper

You must complete these steps if any SNMP management console (HP OpenView, CA UniCenter)
will manage the Linux server.

1. Verify that the dmi2snmp and ucd-snmp packages are installed. For example, the files
dmi2snmp-10-15.i386.rpm and ucd-snmp-4.1.1-15smux.i386.rpm could represent
the dmi2snmp and ucd-snmp packages, respectively.

2. Open the file /etc/snmp/snmpd.conf. You can use any available editor such as vi, emacs,
or a linux editor.

3. Add a trapsink line at the end of the file for each management console that receives traps from
the managed server. Use the following syntax when adding the line:

trapsink <myhost_name.domain.com>

Be sure to substitute appropriate strings for the host name and domain.
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Customizing NetWare Servers After Setup

While installing PIC, the configuration and Setup program installs Adaptec and LSI (Symbios)
SCSI, and Intel® LAN Adapter instrumentation on the NetWare server but does not enable the
instrumentation support.

To enable support for any or all instrumentation, you must edit the AUTOEXEC.NCF file in the
SYS:SYSTEM directory as follows:

Add the line:

rpsstart.ncf

before the line:

isc_on.ncf

To enable the Adaptec SCSI instrumentation, remove the word REM from these lines:

REM load simcinw.nlm

REM load simcinw.nlm

To enable the Intel LAN Adapter instrumentation, remove the word REM from this line:

REM load e100bdmi.nlm /auto

To enable the LSI (Symbios) SCSI instrumentation, remove the word REM from this line:

REM load simcinw.nlm
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Launching ISC

ISC can be launched from and can manage your server from one of these enterprise management
environments:
• LANDesk Server Manager (LDSM)
• HP Network Node Manager
• CA-Unicenter TNG

Once the ISC application is launched from an enterprise management console, the management
console application can terminate, and ISC will continue to operate normally.

ISC can be launched from and can manage your server from a stand-alone ISC Console. The ISC
Console can run as an executable program, as an ActiveX control within an Internet browser, or
within Microsoft Management Console.

LANDesk® Server Manager
The LANDesk Server Manager (LDSM) console dynamically builds its feature set when
communication is established with a managed server. If the managed server is running the ISC, the
LDSM console adds an option for “Intel Server Control” in the Tools branch of the LDSM
navigation tree. Select this option to launch ISC.

HP Network Node Manager
The HP Network Node Manager Console autodetects servers running the ISC Server
Instrumentation software. The Console updates the server bitmap with an ISC server icon for those
servers.

To launch the ISC applet, select an ISC-enabled server on the HP Console network map, and then
select the “Intel Server Control Applet” option from the Tools Menu. Alternatively, you can launch
ISC by selecting an ISC-enabled server on the HP console network map, clicking the right mouse
button, and then selecting the “Intel Server Control” option from the popup menu.

CA-Unicenter TNG
The CA-Unicenter TNG Console autodetects servers running the ISC Server Instrumentation
software if you have enabled the ISC to CA discovery service. To enable discovery, you must start
the “Intel Tng-ISC AutoDiscovery” service. You can start this service from either the TNG
Unicenter “Auto Discovery” dialog or from the Windows NT “Services” applet.

The “Intel Tng-ISC AutoDiscovery” service creates a new “Intel Server Control” TNG object for
each server having the ISC Server Instrumentation software. That TNG object displays on the map
as a child of the “ISC World View” and as a child of the ISC-enabled server. You can view all
ISC-enabled servers under the “ISC World View.”

To launch ISC, right-click on an “Intel Server Control” icon, and select the “Launch ISC” option
from the popup menu.
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Stand-alone ISC Console
Use the stand-alone ISC Console to manage ISC-enabled servers without installing an enterprise
management console application. The environment is implemented as an executable program; as
an application within Microsoft Management Console; or as an ActiveX control that runs within a
“container” application, such as Microsoft Internet Explorer, versions 5.0 or later, or Netscape
Navigator, version 4.0 or later.

To launch the stand-alone ISC Console in its own container, do the following:

1. Click Start, and then point to Programs.
2. Point to Intel server Control Tool, and then point to Intel Server Control.
3. From the Start Menu in Windows, select Start->Programs->Intel Server Control->ISC-Console.

Launching the ISC Console with Internet Browsers

To launch the stand-alone ISC Console within a Web browser, do the following:

1. Run the Internet Browser to be used as a “container” for the ISC Console.
2. Within the browser, choose File->Open.
3. Enter the ISC Console filename, specifying the full path to the file:

%ISCPATH%\MI\EMC\IC\ISC.HTM

The stand-alone ISC Console will be started as the active application within the default Web
browser.

Once the ISC Console is loaded, the location can be saved as a “Bookmark” (Netscape) or a
“Favorite” (Internet Explorer) for easy access in later sessions.

You may also:

1. Locate the file using Windows Explorer, specifying the path:
%ISCPATH%\MI\EMC\IC\ISC.HTM

2. Double-click on the filename to launch the control within the default Web browser.

✏     NOTE
Netscape Navigator requires a plug-in for viewing ActiveX applications.
One that is known to work is ScriptActive†, which is available from
Ncompass Labs, Inc. (see http://www.ncompasslabs.com).
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Launching the ISC Console with Microsoft Management Console

To launch the stand-alone ISC Console within Microsoft Management Console (MMC), do the
following:

1. From a Start Menu in Windows or from the Start->Run selection, run MMC.
2. Within MMC, choose File->Open.
3. Enter the ISC Console filename, specifying the full path to the file:

%ISCPATH%\MI\EMC\IC\ISC.MSC

The ISC stand-alone application will be started as the active application within MMC. You may
also:

1. Locate the file using Windows Explorer, specifying the path:
%ISCPATH%\MI\EMC\IC\ISC.MSC

2. Double-click on the filename to launch the control within MMC.

✏✏✏✏ NOTE
If you have not installed MMC on your console system, you can obtain it
from Microsoft at http://www.microsoft.com/management/mmc/
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Platform Compatibility Matrix

Table 1lists ISC features specific to hardware platforms. In the table, columns present grouped
platforms while rows describe specific features. More general features, which can consist of
multiple specific features, appear in bold type and span an entire row.

Table 1 Platform Compatibility Matrix
PlatformFeatures

L440GX
SRPL81

SRKA4
SPKA4
ISP4400

SBT2
STL2

Summary

• Servers with ISC 2.x
Features

• Complete In-Band
management from
ISC3.1 Console.

• Out-of-Band (OOB)
management –
Modem/Serial only

• No Service Partition

• Servers with ISC 3.x
Features

• Complete In-band and
OOB management
from ISC3.1 console.

• Service Partition

• Complete In-Band
management

• No OOB management.

• No Service Partition

In-band Remote Management (OS based)

Desktop Management
Interface (DMI)
Instrumentation

IA32

• Windows NT SP6A,
2000SP1

• NetWare 4.2, 5.1

• UnixWare 7.1.1

• Linux 6.2 SBE2

IA32

• Windows NT SP6A,
2000SP1

• NetWare 5.1

• UnixWare 7.1.1

• Linux 6.2SBE2

IA32

• Windows NTSP6A,
2000SP1

• NetWare 4.2, 5.1

• UnixWare 7.1.1

• Linux 6.2SBE2

Win32* Console
Platform Instrumentation
Control (PIC)

Yes

• Windows 2000
professional SP1

• Windows 2000
Advanced Server SP1

• Windows NT
Workstation 4.0 SP6A

• Windows 98

Yes

• Windows 2000
professional SP1

• Windows 2000
Advanced Server SP1

• Windows NT
Workstation 4.0 SP6A

• Windows 98

Yes

• Windows 2000
professional SP1

• Windows 2000
Advanced Server SP1

• Windows NT
Workstation 4.0 SP6A

• Windows 98

1 ISC v3.1 is planned to support the SRPL8 server when the system releases
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Table 1 Platform Compatibility Matrix (cont.)
PlatformFeatures

L440GX
SRPL82

SRKA4
SPKA4
ISP4400

SBT2
STL2

Out-of-Band Remote Management

Win32 based Direct
Platform Control (DPC)
Console

Yes Yes No

Remote Management
via Modem/Serial
(DPC over Modem /
Emergency
Management Port
(EMP))

Yes

(Not available on L440GX)

Yes No

Remote Management
via Intelligent Chassis
Management Bus
(ICMB)

Yes Yes No

Remote Management
via LAN
(DPC over LAN)

No Yes No

Sensor Data Record
(SDR)

Yes
No (SRPL8)

Field Replaceable Unit
(FRU)

Yes

System Event Log (SEL)
Access

Yes
No (SRPL8)

Yes No

OOB Sensor access
(Sensor Access limited
to partial set of sensors)

No Yes No

Power Control (Power
On, Power Off, Reset)

Yes Yes No

OOB command for
graceful OS Shutdown

No Yes No

Out-of-Band Alerts

Platform Event Paging
(firmware)

Yes
(Not available on SRPL8)

Yes No
(Not integrated with ISC
software)

Baseboard Management
Controller (BMC) LAN
Alerts (Platform Event
Trap)

No Yes No

(Not integrated with ISC
software)

2 ISC v3.1 is planned to support the SRPL8 server when the system releases
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Table 1 Platform Compatibility Matrix (cont.)
PlatformFeatures

L440GX
SRPL83

SRKA4
SPKA4
ISP4400

SBT2
STL2

In-Band (Instrumentation based) Alerts

Network Alerts (Popup
Messages)

Yes Yes Yes

DMI Indication Yes Yes Yes

SNMP Traps (via DMI-
SNMP Translator)

Yes Yes Yes

ISC Paging Yes
(Not available on SRPL8)

Yes No

BIOS Console Redirection

Over Modem/Serial Yes Yes No

Over LAN No Yes No

Remote Boot/Access of Service Partition

Over Modem/Serial No Yes No

Over LAN No Yes No

Service Partition based features

Client System Setup
Utility (SSU) (Remote
access)

No Yes No

Remote Diagnostics No Yes No

DOS Shell access
(Command Prompt)

No Yes No

File Transfer No Yes No

Remote File execution No Yes No

Pushbutton remote
upgrade of BMC
Firmware

No Yes No

Pushbutton remote
upgrade of BIOS

No Yes No

3 ISC v3.1 is planned to support the SRPL8 server when the system releases

Download from Www.Somanuals.com. All Manuals Search And Download.



26 Installation Guide for the Intel Server Control

Table 1 Platform Compatibility Matrix (cont.)
PlatformFeatures

L440GX
SRPL84

SRKA4
SPKA4
ISP4400

SBT2
STL2

Enterprise Server Management Console (ESMC) Integration’s

LANDesk® Server
Manager (LDSM) 6.1
(Linux/UnixWare servers
are not discovered /
managed by LDSM

Yes Yes Yes

HP OpenView Network
Node Manager 6.1

Yes Yes Yes

CA Unicenter
Framework TNG 2.2

Yes Yes Yes

Web Browser (Microsoft
IE 5.X, Netscape 4.71)

Yes Yes Yes

Microsoft MMC Yes Yes Yes

ISC Standalone Yes Yes Yes

4 ISC v3.1 is planned to support the SRPL8 server when the system releases
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